BIOINFORMATIC ANALYSIS
6. BIOINFORMATIC ANALYSIS

Bioinformatics is the combination of biology and information technology. Basically, bioinformatics is a recently developed science using information to understand biological phenomenon. It broadly involves the computational tools and methods used to manage, analyze and manipulate volumes and volumes of biological data. Bioinformatics is an interdisciplinary approach requiring advanced knowledge of computer science, mathematics and statistical methods for the understanding of biological phenomena at the molecular level.

The term bioinformatics was first introduced in 1990's. Originally, it dealt with the management and analysis of the data pertaining to DNA, RNA and protein sequences. As the biological data is being produced at an unprecedented rate, their management and interpretation invariably requires bioinformatics. Thus, bioinformatics now includes many other types of biological data. Some of the most important ones are listed below:

- Gene expression profiles.
- Protein structure.
- Protein interactions.
- Microarrays (DNA chips).
- Functional analysis of biomolecules.
- Drug designing.

**Broad coverage of Bioinformatics**

Bioinformatics covers many specialized and advanced areas of biology.

**Functional genomics**

Identification of genes and their respective functions.

**Structural genomics**

Predictions related to functions of proteins.

**Comparative genomics**

For understanding the genomes of different species of organisms.
Medical informatics

This involves the management of biomedical data with special reference to biomolecules, *in vitro* assays and clinical trials.

Components of bioinformatics

Bioinformatics comprises three components

1. Creation of data base

This involves organizing, storage and management of biological data sets. The data base are accessible to researchers to know the existing information and submit new entries. Data bases will be of no use until analyzed.

2. Development of algorithms and statistics

This involves the development of tools and resources to determine the relationship among the members of large data sets eg. Comparison of protein sequence data with already existing protein sequences.

3. Analysis of data and interpretation

The appropriate use of components 1 and 2 (given above) to analyze the data and interpret the results in a biologically meaningful manner. This includes DNA, RNA and protein sequences, protein structure, gene expression profiles and biochemical path ways.

Bioinformatics and internet

The internet is an international computer network. A computer net work involves a group of computers that can communicate (usually over a telephone system) and exchange data between users. It is the inter net protocol (IP) that determines how the packets of information are addressed and routed over the network. To access the internet, a computer must have the correct hardware (modem/network cord), appropriate software and permission for access to net work. For this purpose, one has to subscribe to an internet service provider (ISP).
World Wide Web (www)

www involves the exchange of informations over the internet using a programmer called browser. The most widely used browsers are internet explorer and Netscape Navigator.

Biological Databases

The collection of biological data on a computer which can be manipulated to appear in varying arrangements and subsets is regarded as a data base. Each data base has its own web site with unique navigation tool. The biological databases are, in general, publicly accessible.

Applications of bioinformatics

The advent of bioinformatics has revolutionized the advancements in biological science. And biotechnology is largely benefited by bioinformatics. The best example is the sequencing of human genome in a record time which would not have been possible without bioinformatics. A selected list of applications of Bioinformatics are applied in the following areas:

- Sequence mapping of biomolecules (DNA, RNA, proteins).
- Identification of nucleotide sequences of functional genes.
- Finding the sites that can be cut by restriction enzymes.
- Prediction of functional gene products.
- To trace the evolutionary trees of genes.
- For the prediction of 3-diamentional structure of proteins.
- Molecular modeling of biomolecules.
- Designing of drugs for medical treatment.
- Handling of vast biological data which otherwise is not possible.
- Development of models for the functioning of various cells, tissues and organs.
X-ray diffraction studies reveals the following structures of the important enzymes involved in the carbohydrate and fat metabolism.

1. α-Amylase

α-Amylase is an enzyme that hydrolyses alpha-bonds of large alpha-linked polysaccharides such as starch and glycogen, yielding glucose and maltose. It is the major form of amylase found in humans and other mammals. Although found in many tissues, amylase is the most prominent in pancreatic juice and saliva which each have their own isoforms link to chromosome 1p21 (Fried et al., 1987) (Fig. 6-1).

<table>
<thead>
<tr>
<th>Number of Chains</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Groups</td>
<td>495 (287)</td>
</tr>
<tr>
<td>Number of Atoms</td>
<td>3938 (310)</td>
</tr>
<tr>
<td>Number of Helices</td>
<td>21</td>
</tr>
<tr>
<td>Number of Strands</td>
<td>25</td>
</tr>
<tr>
<td>Number of Turns</td>
<td>0</td>
</tr>
<tr>
<td>Number of Bonds</td>
<td>4079</td>
</tr>
</tbody>
</table>

2. α-Glucosidase

The membrane bound intestinal α-glucosidases hydrolyze oligosaccharides, disaccharides and trisaccharides to glucose and other monosaccharides in the small intestine. Inhibition of these enzyme systems reduces the rate of digestion of complex carbohydrates as a result less glucose is absorbed (Kim et al., 2006) (Fig. 6-2).

<table>
<thead>
<tr>
<th>Number of Chains</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Groups</td>
<td>466 (457)</td>
</tr>
<tr>
<td>Number of Atoms</td>
<td>3884 (554)</td>
</tr>
<tr>
<td>Number of Bonds</td>
<td>4118</td>
</tr>
<tr>
<td>Number of Helices</td>
<td>22</td>
</tr>
<tr>
<td>Number of Strands</td>
<td>24</td>
</tr>
<tr>
<td>Number of Turns</td>
<td>0</td>
</tr>
</tbody>
</table>
3. Pancreatic Lipase

Pancreatic lipase is an enzyme (more specifically, a lipase) secreted from the pancreas that uses hydrolysis to break a fat molecule. Bile salts secreted from the liver and stored in the gall bladder are released into the duodenum where they coat and emulsify large fat droplets into smaller droplets, thus increasing the overall surface area of the fat, which allows the lipase to break apart the fat more effectively. The resulting monomers (2 free fatty acids, 1 monoglyceride and glycerol) are then moved by way of peristalsis along the small intestine to be absorbed into the lymphatic system by a specialized vessel called a lacteal. This protein belongs to the pancreatic lipase family. Unlike some pancreatic enzymes like trypsin which are first secreted in the inactive form (e.g., trypsinogen), pancreatic lipase is secreted as the active enzyme (Winkler et al., 1990) (Fig. 6-3).

<table>
<thead>
<tr>
<th>Number of Groups</th>
<th>449</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Atoms</td>
<td>3491</td>
</tr>
<tr>
<td>Number of Bonds</td>
<td>3585</td>
</tr>
<tr>
<td>Number of Helices</td>
<td>14</td>
</tr>
<tr>
<td>Number of Strands</td>
<td>28</td>
</tr>
<tr>
<td>Number of Turns</td>
<td>0</td>
</tr>
</tbody>
</table>

4. Hormone Sensitive Lipase

Hormone sensitive lipase is also known as LIPE is an enzyme which in humans is encoded by the LIPE gene. LIPE is an intracellular neutral lipase that is capable if hydrolyzing a variety of ester. The enzyme has a long and a short form. The long form is expressed in steroidogenic tissues such as testis where it converts cholesteryl esters to free cholesterol for steroid hormone production (Kraemer and Shen, 2003). The short form is expressed in adipose tissue, where it hydrolyzes stored triglycerides to free fatty acids.

LIPE function to hydrolyze the first fatty acid from a triacylglycerol molecule, freeing a fatty acid. It is also known as triglyceride lipase, while the enzyme that cleaves the second fatty acid in the triglyceride is known as diglyceride lipase and the third enzyme that cleaves the final fatty acid is called monoglyceride lipase. Only the initial enzyme is affected by hormones, hence its hormone-sensitive lipase name. The diglyceride and monoglyceride
enzymes are tens to hundreds of times faster, hence HSL is the rate-limiting step in cleaving fatty acids from the triglyceride molecule (Fig. 6-4).

<table>
<thead>
<tr>
<th>Number of Groups</th>
<th>1060 (113)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Atoms</td>
<td>8442 (257)</td>
</tr>
<tr>
<td>Number of Bonds</td>
<td>8839</td>
</tr>
<tr>
<td>Number of Helices</td>
<td>46</td>
</tr>
<tr>
<td>Number of Strands</td>
<td>28</td>
</tr>
<tr>
<td>Number of Turns</td>
<td>0</td>
</tr>
</tbody>
</table>

5. Lipoprotein Lipase

Lipoprotein lipase is an enzyme that hydrolyzes lipids in lipoproteins, such as those found in chylomicrons and very low-density lipoproteins (VLDL), into two free fatty acids and one monoacylglycerol molecule. It requires Apo-CII as a cofactor. Lipoprotein lipase is specifically found in endothelial cells lining the capillaries. LPL encodes lipoprotein lipase, which is expressed in heart muscle and adipose tissue. LPL functions as a homodimer and has the dual functions of triglyceride hydrolase and ligand/bridging factor for receptor-mediated lipoprotein uptake. Severe mutations that cause LPL deficiency result in type I hyperlipoproteinemia, while less extreme mutations in LPL are linked to many disorders of lipoprotein metabolism (Perry, 2007) (Fig. 6-5).

<table>
<thead>
<tr>
<th>Number of Groups</th>
<th>898 (707)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Atoms</td>
<td>7002 (707)</td>
</tr>
<tr>
<td>Number of Bonds</td>
<td>7176</td>
</tr>
<tr>
<td>Number of Helices</td>
<td>18</td>
</tr>
<tr>
<td>Number of Strands</td>
<td>38</td>
</tr>
<tr>
<td>Number of Turns</td>
<td>0</td>
</tr>
</tbody>
</table>

Preparation of Receptor for important enzymes: α-Amylase, α-Glucosidase, Pancreatic Lipase, Hormone Sensitive Lipase and Lipoprotein Lipase

Sequence Retrieval

Protein Sequence has been retrieved from PDB (Protein Data Bank) database which is a primary and secondary database from all kind of protein sequence and the matrix data from Crystallographic techniques. The web site address of PDB is [www.pdb.org](http://www.pdb.org)
The **Protein Data Bank (PDB)** is a repository for the 3-D structural data of large biological molecules, such as proteins and nucleic acids. The data, typically obtained by X-ray crystallography or NMR spectroscopy and submitted by biologists and biochemists from around the world, can be accessed at no charge on the internet. The PDB is a key resource in areas of structural biology, such as structural genomics. If the contents of the PDB are thought of as primary data, then there are hundreds of derived (i.e., secondary) databases that categorize the data differently.

### Table 6.1 Sequence Annotation of important enzymes

<table>
<thead>
<tr>
<th>Enzyme Name</th>
<th>PDB ID</th>
<th>Sequence</th>
<th>Functional sites</th>
</tr>
</thead>
<tbody>
<tr>
<td>α-Amylase</td>
<td>3M07</td>
<td>618</td>
<td>4</td>
</tr>
<tr>
<td>α-Glucosidase</td>
<td>2F2H</td>
<td>773</td>
<td>12</td>
</tr>
<tr>
<td>Pancreatic Lipase</td>
<td>2OXE</td>
<td>466</td>
<td>3</td>
</tr>
<tr>
<td>Hormone Sensitive</td>
<td>3FAK</td>
<td>322</td>
<td>4</td>
</tr>
<tr>
<td>Lipoprotein Lipase</td>
<td>1HIPL</td>
<td>499</td>
<td>5</td>
</tr>
</tbody>
</table>

**PyMol**

**PyMOL** is a molecular visualization system created by Warren Lyford De Lano and commercialized by De Lano Scientific LLC. It is well suited to produce high quality 3D images of small molecules and biological macromolecules such as proteins. Our five kinds of enzymes structures were viewed at 1-3 Armstrong visual category (Fig. 6.1 – Fig. 6.5).

**Preparation of Ligand for Mangiferin and Salacinol**

**ChemSketch ACD LAB**

The ACD/ChemSketch contains tools for 2D structure cleaning, 3D optimization and viewing, In ChI generation and conversion, drawing of polymers, organometallics, Markush structures etc., (Gary, 1998). The 3D optimization is based on modified molecular mechanics which take into account bond stretching, angle bending, internal rotation and Van der Waals non-bonded interactions. Here we have calculated energy level of each atomic position of mangiferin and salacinol and drawn the 3 Dimensional Structure and optimized. This has been viewed under 1 A and saved in .mol file format.
Open Babel

Open Babel is a chemical tool box designed to speak many languages of chemical data. It is an open, collaborative project allowing anyone to search, convert, analyze or store data from molecular modeling, chemistry, solid-state materials, biochemistry or related areas. All kind of in silico analysis of both Protein and Ligand will work under .pdb format. Conversion of .mol format into .pdb format have been depicted from this tool. The specifications of changeover is given below:

Nature of .mol format

ACD/Labs93201016153D
4 50 0 0 0 0 0 0 0 0 1 V2000
15.3854 -25.6574 0.9546 C 0 0 0 0 0 0 0 0 0 0 0
14.5094 -27.0019 4.1977 O 0 0 0 0 0 0 0 0 0 0 0
13.9780 -26.5483 2.9610 C 0 0 0 0 0 0 0 0 0 0 0
15.9553 -27.8101 2.2959 O 0 0 0 0 0 0 0 0 0 0 0
14.8544 -27.0360 1.7917 C 0 0 0 0 0 0 0 0 0 0 0

Conversion performed into .pdb format

<table>
<thead>
<tr>
<th>COMPO</th>
<th>UNNAMED</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTHOR</td>
<td>GENERATED BY OPEN BABEL 2.2.3</td>
</tr>
<tr>
<td>HETATM</td>
<td>1 C LIG 1</td>
</tr>
<tr>
<td>HETATM</td>
<td>2 O LIG 1</td>
</tr>
<tr>
<td>HETATM</td>
<td>3 C LIG 1</td>
</tr>
<tr>
<td>HETATM</td>
<td>4 O LIG 1</td>
</tr>
<tr>
<td>HETATM</td>
<td>5 C LIG 1</td>
</tr>
</tbody>
</table>

Autodock 4

Autodock is a suite of automated docking tools (David et al., 2004). It is designed to predict how small molecules, such as substrates or drug candidates, bind to a receptor of known 3D structure. AutoDock actually consists of two main programs: AutoDock performs the docking of the ligand to a set of grids describing the target protein. AutoGrid pre-calculates these grids. In addition to using them for docking, the atomic affinity grids can be visualised. This can help, for example, to guide organic synthetic chemists design better binders. We have also developed a graphical user interface called AutoDock Tools or ADT for short, which amongst other things helps to set up which bonds will be treated as rotatable
in the ligand and to analyze dockings. Docking calculation in Autodock was performed using the receptor protein and the inhibitors.

This process included the following steps (http://autodock.scripps.edu/help/tutorial):

1. Preparation of receptor and ligand files.
2. Calculation of affinity maps by using a 3D grid around the receptor and ligand.
3. Defining the docking parameters and running the docking simulation.

Preparing Enzyme complex for Docking

Receptor complex was loaded in ADT (Auto Dock Tools) by choosing “Read Molecule” from “File” menu. This opened a file browser, showing all the files in the current directory from which the PDB file was selected and clicked. The protein molecule was colored. In order to remove water molecules, “Select from string” was selected from “select” menu and HOH* was written in Residue line. Delete option from Edit menu was selected and Delete Atom Set was clicked. Hydrogen bonds were added by selecting the Edit menu and clicking Add All hydrogens. This altered structure was saved as receptor.pdbqt.

Preparing the ligand

Ligand is opened by clicking open option in Ligand submenu. This option opened the ligand Mangiferin.pdb. This structure contained hydrogen atoms which were added earlier. ADT automatically computed Gangster charges and merged nonpolar hydrogens. The rigid portion of the ligand molecule was selected by clicking the Torsion Tree option and Detect Root was selected. Number of rotatable bonds was selected by choosing Set Number of Torsion option from Ligand menu. This modified ligand.pdb was saved in PDBQT file format. Similarly other two ligands were also prepared for docking.

Preparing the flexible residue file

The protein molecule in PDB format was loaded as input in Flexible residues menu. Non polar hydrogens were merged. The residues which were to be flexible had been selected from Select option. These residues were added in the active site. Torsions had been set in the selected residues by clicking the option to define the rotatable bonds. These flexible residues were saved in PDBQT format with the name receptorqt.pdbqt.
Running Autogrid 4

To define the search grid and to produce the grid maps, grid calculation was run by Autogrid. For this the receptorq4.pdbqt macromolecule was opened in Grid. Set Map types was selected to choose ligand.pdbqt and Accept option was clicked. Grid properties were set and a grid box created. This was saved as outputgrid.gpf. These files were kept in the same directory where Autogrid executable file was saved. To run grid calculations Run Autogrid was selected and launched.

Preparing the docking parameter file

The docking calculations had been begun with specifying the rigid molecule receptorq4.pdbqt. In docking menu the rigid macromolecule was opened. Ligand file was opened from the same menu by clicking on the .pdbqt. Set Flexible residue file name was selected to open the flexible residue pdbqt file. Genetic algorithm was selected as the search parameter for docking. Medium number of evaluations were added and accepted for the calculation. Default docking parameters had been chosen for the present study. Docking instructions had been written to outputdock.dpf file in Lamarckian GA. The details of docking were confirmed by opening and editing the .dpf file.

Running Autodock 4

Run Autodock was selected and launched for docking calculation. The results were viewed by reading the .dlg file in Analyze menu. The .dlg file was opened and different conformations were loaded in their increasing order of energy. Play option was selected to visualize the conformations. Similarly docking calculation for other two ligands and the best binding models were analyzed.

Results and Discussion

AutoDock Results

It has been procedurized by taking nearly 2 compounds i.e Mangiferin and Salacinol for post docking analysis study against the five enzymatic reaction I theoretical approach were performed. From this theoretical experiment, the suitable ligand which has more interacting hydrogen bonds and which has least docking energy score were selected as the inhibitor for the five kind of enzyme reaction. Tables 6.2 and 6.3, Fig. 6.30 – Fig. 6.33 show
the list of ligands has the number of hydrogen bonds and the least binding energy. Most of the inter-atomic distance is formed in the nitrogen and oxygen atoms (Fig. 6.10 - Fig. 6.29)

In the concise context of above mentioned receptor types that could effectively control Type II diabetes and obesity from enzymatic process in, α-amylase, α-glucosidase, hormone sensitive lipase, pancreatic lipase, lipoprotein lipase. Mangiferin and Salacinol inhibit more in cellular level process. Active site prediction of protein shows ten actively participating residues by its energy based prediction. It varies in all five receptor by its prediction. According to autodock score i.e energy potential and internal energy system must be low in the interaction profile. As it is mentioned, among five kind of enzymatic inhibition from mangiferin pancreatic lipase shows more inhibitory form and lipoprotein lipase with salacinol. Observation of atomic level interaction shows oxygen and nitrogen atoms paves the way to interact with protein and ligand complex.

In the theoretical chemistry, to confirm from bond length we could manage with two atoms and its probable amount of atomic radii i.e atomic radii of two atoms forms bond length. Bond length has some limit to manage the energy level in the Autodock procedure. Upper limit and lower limit of the interaction. Upper limit considers adding of two atomic radii and lower limit considers minimum possible length to interact. It is now computationally proved by docking procedure and its algorithmic form by observing energy value and its number of hydrogen bonds formed between receptor and ligand. Mangiferin has 7 hydrogen bond with receptor and performing more receptive and Salacinol has 5 hydrogen bond with receptor performing more receptive. It is generally the theoretical consideration of computational hypothesis and applied to our results and observed lower energy value gives more stable active compound for the control of Type II diabetes and obesity and accepts the protocol of LJ Potential of receptor and ligand interaction. These studies will help for the in silico drug discovery for the serious metabolic disorders diabetes and obesity in human beings.
Fig 6.1 Alpha amylase (3M07) in 1 Å view; Fig 6.2 Alpha Glucosidase (2F2H) in 1 Å view;
Fig 6.3 Pancreatic Lipase (2OXE) in 1 Å view; Fig 6.4 Hormone Sensitive Lipase (3FAK) in 1 Å view;
Fig 6.5 Lipoprotein Lipase (1HPL) in 1 Å view (Ribbon model).
Fig. 6.6  3 Dimensional Conformation of Mangiferin

Fig. 6.7  2 Dimensional structure of Mangiferin
Fig. 6.8 3 Dimensional Conformation of Salacinol

Fig. 6.9 2 Dimensional Structure of Salacinol
**Fig. 6.10 & 6.11 α-Amylase vs Mangiferin** - Residues from receptor ASP 79, ILE 251, LYS 107, GLU 83 and its atom types OA, OBI-(Oxygen), N1-(Nitrogen), H6-(Hydrogen) interacting with Ligand atom types OB, OBI, OBE, OAI (Oxygen) correspondingly in the Armstrong distance of bond length as 3.03Å, 3.92Å, 3.29Å, 3.23Å.

**Abbreviations:** ASP-Aspartic acid, GLU-Glutamic acid, ILE-Isoleucine, LYS-Lysine.
**Fig. 6.12** Cartoon Representation

**Fig. 6.13** Surface Representation

**Fig. 6.12 & 6.13 α-Amylase vs Salacinol** - Residues from receptor SER 300, GLY 267, GLY 213, GLY 198, GLY 212 and its atom types HA-Hydrogen, OB3-(Oxygen), OB1, O2, HB interacting with Ligand atom types O, OA1, NH-Nitrogen, NA, NB corresponding in the Armstrong distance of bond length as 3.24Å, 3.31Å, 3.09Å, 2.16Å, 3.26Å.

**Abbreviations:** GLY-Glycine, SER-Serine.
Fig 6.14 Cartoon Representation

Fig 6.15 Surface Representation

**Fig. 6.14 & 6.15** α-Glucosidase vs Mangiferin - Residues from receptor THR 287, ILE 291, ARG 283, ALA 315 and its atom types OA, OBA-(Oxygen), N1, NB-(Nitrogen), interacting with Ligand atom types OA, OB4 (Oxygen), NB, N1-Nitrogen correspondingly in the Armstrong distance of bond length as 2.59Å, 2.34Å, 3.14Å, 3.34Å.

**Abbreviations:** ALA-Alanine, ARG-Arginine, ILE-Isoleucine, THR-Threonine.
**Fig 6.16** Cartoon Representation

**Fig 6.17** Surface Representation

**Fig. 6.16 & 6.17 α-Glucosidase vs Salacinol** - Residues from receptor SER456, ILE345, ILE300, ASN212, GLU413 and its atom types OA, HA, HB, OB, OH1 interacting with Ligand atom types NA, OAB, OAI, NAB, NB3 correspondingly in the Armstrong distance of bond length as 3.07Å, 2.26Å, 2.75Å, 3.53Å, 3.14Å.

**Abbreviations**: ASN-Asparagine, GLU-Glutamic acid, ILE-Isoleucine, SER-Serine.
Fig 6.18 Cartoon Representation

Fig 6.19 Surface Representation

**Fig. 6.18 & 6.19 Pancreatic Lipase vs Mangiferin** - Residues from receptor HIS 268, SER 244, ARG 286, VAL 24 and its atom types N1, NB, NO-(Nitrogen), OA, OBA-(Oxygen), interacting with Ligand atom types OA, OBI, OBI, OAL, OBI (Oxygen), correspondingly in the Armstrong distance of bond length as 2.59Å, 2.57Å, 3.47Å, 2.59Å, 3.12Å.

**Abbreviations**: ARG-Arginine, HIS-Histidine, SER-Serine, VAL-Valine.
Fig 6.20 Cartoon Representation

Fig 6.21 Surface Representation

**Fig. 6.20 & 6.21 Pancreatic lipase vs Salacinol** - Residues from receptor HIS 268, SER 244, ARG 286, VAL 24 and its atom types N1, NB, NO-(Nitrogen), OA, OBA-(Oxygen), interacting with Ligand atom types OA, OB4, OB, OAL, OBI (Oxygen), correspondingly in the Armstrong distance of bond length as 2.59 Å, 2.57 Å, 3.47 Å, 2.59 Å, 3.12 Å.

**Abbreviations:** ARG-Arginine, HIS-Histidine, SER-Serine, VAL-Valine.
Fig. 6.22 Cartoon Representation

Fig. 6.23 Surface Representation

**Fig. 6.22 & 6.23 Hormone sensitive lipase vs Mangiferin** - Residues from receptor ILE 291, ARG 283, ILE 286, GLY 311 and its atom types N1, N2-Nitrogen, O, OBA-(Oxygen), interacting with Ligand atom types OA, OB4, OBI, OAI (Oxygen), correspondingly in the Armstrong distance of bond length as 2.79Å, 3.56Å, 2.60Å, 3.00Å.

**Abbreviations:** ARG-Arginine, GLY-Glycine, ILE-Isoleucine.
**Fig. 6.24 & 6.25 Hormone sensitive lipase vs Sulacinol** - Residues from receptor GLU 234, ARG 240, ARG 411, ALA 506, ILE 312 and its atom types O-A, O-B-A, O-A, O-A interacting with Ligand atom types O-D, N-A, N-H, N-B, N-L correspondingly in the Armstrong distance of bond length as 2.46 Å, 3.35 Å, 3.00 Å, 3.17 Å, 2.18 Å.

**Abbreviations:** ALA-Alanine, ARG-Arginine, GLU-Glutamic acid, ILE-Isoleucine.
**Fig. 6.26** Cartoon Representation

**Fig. 6.27** Surface Representation

**Fig. 6.26 & 6.27 Lipoprotein lipase vs Mangiferin** - Residues from receptor ASP 482, ARG 466, HIS 540, ASP 306 and its atom types N1, NB, NA1, NO-Nitrogen), OA, OBA-(Oxygen), interacting with Ligand atom types OA, OB4, OB1, OA1, OA2, OD1 (Oxygen), correspondingly in the Armstrong distance of bond length as 2.46 Å, 3.38 Å, 3.63 Å, 2.20 Å, 3.27 Å, 2.22 Å.

**Abbreviations:** ARG-Arginine, ASP-Aspartic acid, HIS-Histidine.
Fig 6.28 Cartoon Representation

Fig 6.29 Surface Representation

**Fig. 6.28 & 6.29 Lipoprotein lipase vs Salacinol** - Residues from receptor PHE 312, ARG 345, GLN 112 and its atom types OA, OBI, OH1 interacting with Ligand atom types CA, OHA, NA correspondingly in the Armstrong distance of bond length as 3.52 Å, 2.12 Å, 2.29 Å.

**Abbreviations:** ARG-Arginine, GLN-Glutamine, PHE-Phenylalanine.
### Table 6.2 Interaction of enzymes with *Salacinol* compound

<table>
<thead>
<tr>
<th>Enzyme Name</th>
<th>Interacted residues</th>
<th>Atoms Interacted</th>
<th>Binding Energy</th>
<th>No of Bond formed</th>
<th>Bond Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>α Amylase</td>
<td>GLU 234, ARG 240, ARG 411, ALA 506, ILE 312.</td>
<td>O-O, O-N, O-N, O-N</td>
<td>-3.52</td>
<td>5</td>
<td>O-O=2.46, O-N=3.35, O-N=3.00, O-N=3.17, O-N=2.18</td>
</tr>
<tr>
<td>α Glucosidase</td>
<td>PHE 312, ARG 345, GLN 112</td>
<td>O-C, O-O, O-N</td>
<td>-2.12</td>
<td>3</td>
<td>O-C=3.52, O-O=2.12, O-N=2.29</td>
</tr>
<tr>
<td>Hormone Sensitive Lipase</td>
<td>GLU 222, GLY 301, ALA 103</td>
<td>O-O, O-N, O-N</td>
<td>-3.95</td>
<td>3</td>
<td>O-O=2.62, O-N=3.12, O-N=1.83</td>
</tr>
</tbody>
</table>
Fig. 6.30
Deviation of Binding Energy – Salacinol

Fig. 6.31
Number of Hydrogen bonds formed – Salacinol
<table>
<thead>
<tr>
<th>Enzyme Name</th>
<th>Interacted residues</th>
<th>Atoms Interacted</th>
<th>Binding Energy</th>
<th>No of Bond formed</th>
<th>Bond Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>α-Amylase</td>
<td>GLY 185, ILE 325, ILE 201, ARG 312</td>
<td>O-O, O-N, O-N</td>
<td>-4.01</td>
<td>4</td>
<td>O-O=2.46, O-N=3.35, O-N=3.00</td>
</tr>
<tr>
<td>Hormone Sensitive Lipase</td>
<td>VAL 312 ALA 198 SER 321 HIS 167 ARG 190</td>
<td>O-N, O-N, O-O, O-N, O-N</td>
<td>-3.05</td>
<td>5</td>
<td>O-N=3.12, O-N=2.59, O-N=2.59, O-N=3.47</td>
</tr>
<tr>
<td>Lipoprotein Lipase</td>
<td>ALA 124 ARG 415 GLY 250 GLY 401 TRP 109</td>
<td>O-O, O-N, O-N, O-O, H-O</td>
<td>-4.06</td>
<td>5</td>
<td>O-O=3.20, O-N=3.03, O-N=3.18, O-O=2.64, H-O=2.51</td>
</tr>
</tbody>
</table>
Fig. 6.32
Deviation of Binding Energy – Mangiferin

Fig. 6.33
Number of Hydrogen bonds formed – Mangiferin